
1) Trong excel, cách nào sau đây dùng để thiết lập Font mặc định  

a) Chọn File->Options->Genral, tại mục Use this as the default font, chọn Font mặc 

định 

b) Chọn Home->Font->Genral, chọn tab Font, chọn Font mặc đinh 

c) Chọn Home->trong nhóm lệnh Font, chọn Font mặc đinh 

d) Chọn File->Options->Advanced, tại mục Use this as the default font, chọn Font mặc 

đinh 

2) Trong excel, cách nào sau đây dùng để xuống dòng trong một ô 

a) Enter 

b) Shift + Enter 

c) Alt + Enter 

d) Ctrl + Enter 

3) Chức năng nào sau đây làm cho nội dung trong một ô tự động xuống dòng khi gặp lề 

phải của ô 

a) Wrap text 

b) Shrink to fit 

c) Merge cells 

d) Merge across 

4) Để sao chép giá trị của dữ liệu từ vị trí này đến vị trí khác trong bảng tính của excel, 

lựa chọn nào sau đây là đúng? 

a) Đặt trỏ tại vị trí cần sao chép, click nút Paste trong nhóm lệnh Clipboard 

b) Đặt trỏ tại vị trí cần sao chép, click mũi tên bên dưới nút Paste, chọn Paste special, 

chọn values 

c) Đặt trỏ tại vị trí cần sao chép, click mũi tên bên dưới nút Paste, chọn Paste special, 

chọn all 

d) Đặt trỏ tại vị trí cần sao chép, click mũi tên bên dưới nút Paste, chọn Paste special, 

chọn Data 

5) cách nào sau đây dùng để sao chép dữ liệu trong dãy ô A1:A4 thành dòng từ C1:F1 



a) Chọn các ô A1:A4, click nút Copy, Click chuột phải trên ô C1, chọn Paste Special, 

chọn Transpose 

b) Chọn các ô A1:A4, click nút Copy, Click chuột phải trên ô C1, chọn Paste  

c) Chọn các ô A1:A4, click nút Copy, Click chuột phải trên ô A1, chọn Paste Special, 

chọn Rows 

d) Chọn các ô A1:A4, click nút Copy, Click chuột phải trên ô C1, chọn Paste Link 

6) Ô A1 chứa giá trị 0.1, sử dụng chức năng Fill để điền dữ liệu cho các ô từ A2, A3, … 

các giá trị theo quy tắc 0.6, 1.1, 1.6, 2.1, … và giá trị kết thúc là 3, thao tác nào sau đây 

là đúng? 

a) Đặt trỏ trong ô A1, chọn Fill-> Series, tại mục Series in, chọn Columns, tại ô Step 

values, nhập giá trị 0.5, stop values, nhập giá trị 3 

b) Đặt trỏ trong ô A1, chọn Fill-> Series, tại mục type, chọn Autofill, tại ô Step values, 

nhập giá trị 0.5, stop values, nhập giá trị 3 

c) Đặt trỏ trong ô A1, chọn Fill-> Series, tại mục type, chọn Linear, tại ô Step values, 

nhập giá trị 0.4, stop values, nhập giá trị 3 

d) Đặt trỏ trong ô A1, chọn Fill-> Series, tại mục type, chọn Growth, tại ô Step values, 

nhập giá trị 0.6, stop values, nhập giá trị 3 

7) Ô A1 chứa giá trị 0.5, A2 chứa giá trị 2, dùng chức năng Fill để điển dữ liệu cho các ô 

kế tiếp trong cột A theo quy luật như hình, thao tác nào sau đây là đúng? 

a) Chọn các ô từ A1:A8, chọn Fill -> Series, trong nhóm Type, chọn 

Growth, Chọn Trend 

b) Chọn các ô từ A1:A8, chọn Fill -> Series, trong nhóm Type, chọn 

Linear 

c) Chọn các ô từ A1:A8, chọn Fill -> Series, trong nhóm Type, chọn 

AutoFill, chọn Trend 

d) Chọn các ô từ A1:A8, chọn Fill -> Series, trong nhóm Type, chọn Growth 

8) Ô A1 chứa giá trị 15/04/2016, dùng chức năng Fill để điền giá trị cho dãy ô A2:A10, là 

những ngày làm việc trong tuần bắt đầu từ ngày 15/04/2016, thao tác nào sau đây là 

đúng? 

phucpd
Highlight

phucpd
Highlight

Student
Highlight

Student
Highlight



a) Chọn dãy ô A1:A10, chọn Fill-> Series, trong mục Date unit, chọn Weekday 

b) Chọn dãy ô A2:A10, chọn Fill-> Series, trong mục Date unit, chọn Weekday 

c) Chọn dãy ô A1:A10, chọn Fill-> Series, trong mục Type, chọn AutoFill 

d) Chọn dãy ô A2:A10, chọn Fill-> Series, trong mục Type, chọn Date 

9) Thao tác nào sau đây dùng để xóa định dạng trong một ô hoặc dãy các ô 

a) Chọn các ô cần xóa định dạng, trong nhóm lệnh Editing, click nút Clear, chọn Clear 

Formats 

b) Chọn các ô cần xóa định dạng, trong nhóm lệnh Cells, click nút Clear, chọn Formats 

c) Chọn các ô cần xóa định dạng, nhấn phím Delete 

d) Chọn các ô cần xóa định dạng, trong nhóm lệnh Cells, click nút Delete, chọn Delete 

Cells 

10) Thao tác nào sau đây dùng để định dạng những điểm thi có giá trị cao hơn điểm thi 

trung bình của cả lớp có kiểu in đậm và màu đỏ 

a) Chọn cột điểm thi, click nút Conditional Formatting trong nhóm lệnh Style, chọn 

New Rule, chọn rule: Format only values that are above or below average, click 

format, chọn Font Style: Bold và Color: Red 

b) Chọn cột điểm thi, click nút Conditional Formatting trong nhóm lệnh Style, chọn 

Top/Bottom Rules -> Above Average -> Red Text. 

c) Chọn cột điểm thi, click nút Conditional Formatting trong nhóm lệnh Style, chọn 

Top/Bottom Rules -> Below Average -> Red Text.. 

d) Chọn cột điểm thi, click nút Conditional Formatting trong nhóm lệnh Style, chọn 

New Rule, chọn rule: Format only values that are Below or below average, click 

format, chọn Font Style: Bold và Color: Red 

11) Để cố định phần tiêu đề của bảng tính tại hai dòng 1 và 2, thao tác nào sau đây là đúng? 

a) Chọn dòng thứ 3 của bảng tính, trong nhóm lệnh Window của tab View, click nút 

Freeze Panes, chọn Freeze Panes 

b) Chọn 2 dòng 1 và 2 của bảng tính, trong nhóm lệnh Window của tab View, click 

nút Freeze Panes, chọn Freeze Panes 
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c) Chọn dòng thứ 3 của bảng tính, trong nhóm lệnh Window của tab Review, click nút 

Freeze Panes, chọn Freeze Panes 

d) Đặt trỏ trong bảng tính, trong nhóm lệnh Window của tab View, click nút Freeze 

Panes, chọn Freeze Panes 

12) Kiểu View nào sau đây cho phép người dùng có thể nhập nội dung cho Header và Footer 

của bảng tính 

a) Normal view 

b) Page layout view 

c) Page break preview 

d) Print preview 

13) Mặc định khi thực hiện thao tác in, excel sẽ in toàn bộ bảng tính, cách nào sau đây dùng 

để in một vùng dữ liệu được chỉ định 

a) Chọn vùng dữ liệu cần in, chọn tab Page Layout, trong nhóm lệnh Page Setup, Click 

nút Print area, chọn Set Print area 

b) Chọn vùng dữ liệu cần in, chọn tab File, chọn Print, Click nút Print area, chọn Set 

Print area 

c) Chọn vùng dữ liệu cần in, chọn tab File, chọn Print, click Page Setup, chọn nút Print 

area 

d) Chọn vùng dữ liệu cần in, chọn File -> Print->Print 

14)  Kiểu View nào sau đây cho phép người dùng chỉ có thể xem nội dung của Header và 

Footer của bảng tính 

a) Normal view 

b) Page layout view 

c) Page break preview 

d) Print preview 

15) Kiểu View nào sau đây cho phép người dùng có thể xem dấu ngắt trang của bảng tính 

a) Normal view 

b) Page layout view 

c) Page break preview 
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d) Print preview 

16) Trong bảng tính Excel, thao tác nào sau đây dùng để chèn dấu ngắt trang 

a) Đặt trỏ tại vị trí ngắt trang, chọn tab Page Layout-> Breaks-> Insert Page Break 

b) Đặt trỏ tại vị trí ngắt trang, chọn tab Insert-> Page break 

c) Đặt trỏ tại vị trí ngắt trang -> click chuột phải và chọn Insert Page Break 

d) Đặt trỏ tại vị trí ngắt trang-> chọn tab Insert-> Insert Page break 

17) Để tiêu đề của bảng tính lặp lại tài đầu của mỗi trang, thao tác nào sau đây là đúng? 

a) Mở hộp thoại Page Setup, chọn tab Sheet, trong mục Print titles, đưa trỏ vào ô Rows 

to repeat at top, chọn các dòng cần lặp lại ở đầu trang, click OK. 

b) Mở hộp thoại Page Setup, trong mục Print titles, đưa trỏ vào ô Rows to repeat at 

top, chọn các dòng cần lặp lại ở đầu trang, click OK. 

c) Chọn bảng tính, mở hộp thoại Page Setup, trong mục Print titles, đưa trỏ vào ô Rows 

to repeat at top, chọn các dòng cần lặp lại ở đầu trang, click OK. 

d) Mở hộp thoại Page Setup, chọn dãy các ô cần lặp lại ở đầu mỗi trang, đưa trỏ vào ô 

Rows to repeat at top, click OK. 

18) Thao tác nào sau đây dùng để chèn tên tập tin excel (tên của workbook) vào header của 

bảng tính sao cho khi thay đổi tên tập tin thì tên tập tin trong header tự động cập nhật 

theo 

a) Chọn tab Insert, trong nhóm lệnh Text, chọn Header&Footer, đặt trỏ trong phần 

header, trong nhóm lệnh Header&Footer elements của tab design, chọn File name 

b) Chọn tab Insert, trong nhóm lệnh Header&Footer, đặt trỏ trong phần header, trong 

nhóm lệnh Header&Footer elements của tab design, chọn File name 

c) Chọn tab Insert, trong nhóm lệnh Page Setup, chọn Header&Footer, đặt trỏ trong 

phần header, trong nhóm lệnh Header&Footer elements của tab design, chọn File 

name 

d) Chọn tab insert, trong nhóm lệnh Text, chọn Header&Footer, trong phần header, 

nhập tên tập tin 

19) Tổ hợp phím nào sau đây dùng để di chuyển con trỏ đến ô cuối cùng của bảng dữ liệu 

a) Ctrl + End 
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b) Ctrl + Shift + End 

c) Shift + End 

d) Alt + End 

20) Cách nào sau đây để di chuyển trỏ đến cột cuối cùng của worksheet 

a) Nhấn phím End, sau đó nhấn tổ hợp phím Ctrl +  

b) Nhấn phím End, sau đó nhấn tổ hợp phím Ctrl + End 

c) nhấn tổ hợp phím  Ctrl +  

d) nhấn tổ hợp phím Shift + End 

21) Nếu định dạng dữ liệu kiểu số trong một ô hoặc dãy ô có dạng: [Blue]#,## 

0);[Red](#,##0); thì khi nhập giá trị vào ô, kết quả sẽ hiện thị như thế nào? 

a) Số dương màu xanh, số âm màu đỏ đặt trong cặp dấu () 

b) Số dương màu đỏ, số âm màu xanh đặt trong cặp dấu () 

c) Số dương màu xanh đặt trong cặp dấu (), số âm màu đỏ  

d) Số dương màu xanh, số âm màu đỏ  

22) Định dạng màu xanh lá cho tất cả số âm trong 1 cột dữ liệu, chọn mẫu định dạng nào 

sau đây? 

a) $0.00;[green]#,##0.00; 

b) ;[green]#,##0.00; 

c) $0.00;[green]#,##0.00; 

d) $0.00;[red]$0.00;"Zero";[green]@ 

23) Dùng chức năng Define Name định nghĩa tên cho ô A1 là tigia, tên tigia tương ứng với 

loại địa chỉ nào sau đây 

a) A1 

b) $A$1 

c) A$1 

d) $A1 

24) Cách nào sau đây dùng để xóa tên của ô và dãy các ô đã được định nghĩa 

a) Chọn tab Formulas -> Name Manager-> chọn tên của ô hoặc dãy các ô cần xóa -> 

Delete 
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b) Chọn tab Data -> Name Manager-> chọn tên của ô hoặc dãy các ô cần xóa -> Delete 

c) Chọn tab Home -> Name Manager-> chọn tên của ô hoặc dãy các ô cần xóa -> 

Delete 

d) Chọn ô hoặc dãy các ô cần xóa tên -> Delete 

25) Trong excel, tên của ô hoặc dãy ô được định nghĩa có giá trị trong phạm vi nào? 

a) Trong Worksheet chứa ô hoặc dãy ô được định nghĩa tên 

b) Trong toàn bộ Workbook 

c) Trong tất cả các workbook 

d) Không có giá trị trong bất kỳ phạm vi nào 

26) Một công thức trong Excel được bắt đầu bằng dấu: 

a) = 

b) + 

c) * 

d) = hoặc + 

27) Giá trị trong ô A1 là 3, hãy cho biết kết quả của biểu thức =Mod(A1*3, A1*4) là gì? 

a) 3 

b) 4 

c) 9 

d) 12 

28) Hãy cho biết kết quả của công thức sau 

 =IF(MIN(A1:B1)>=5=TRUE,AVERAGE(A1:B1),0)  

a) 0 

b) True 

c) False 

d) Công thức sai cú pháp 

29) Giá trị trong các ô A1, B1, C1 lần lượt là 6, 30 và 170, hãy cho biết công thức nào sau 

đây tương đương với công thức =IF(A1*B1>C1,C1,A1*B1) 

a) =MIN(A1*B1,C1) 

b) =IF(A1*B1<C1,A1*B1,C1) 
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c) =IF(MIN(A1*B1,C1)=C1,C1,A1*B1) 

d) Tất cả các lựa chọn đều tương đương 

30) Dùng chức năng Fill điền vào dãy các ô C2:C21 các giá trị: $3.00, $2.95, $2.90, … 

$2.05, thao tác nào sau đây là đúng 

a) Nhập giá trị $3.00 vào ô C2, chọn các ô C2:C21, trong nhóm lệnh editing của tab 

Home, chọn Fill -> Series, trong ô Step value: nhập -0.5, Stop value: nhập 2.05 -

>OK 

b) Nhập giá trị $3.00 vào ô C2, chọn các ô C3:C21, trong nhóm lệnh editing của tab 

Home, chọn Fill -> Series, trong ô Step value: nhập -0.5, Stop value: nhập 2.05 -

>OK 

c) Nhập giá trị $3.00 vào ô C2, chọn các ô C2:C21, trong nhóm lệnh editing của tab 

Home, chọn Fill -> Series, trong ô Step value: nhập 0.5, Stop value: nhập 2.05 -

>OK 

d) Nhập giá trị $3.00 vào ô C2, chọn các ô C2:C21, trong nhóm lệnh editing của tab 

Home, chọn Fill -> Series, trong mục Type chọn AutoFill->OK 

31) Thao tác nào sau đây dùng để sao chép một worksheet thành một Workbook mới 

a) Click chuột phải trên tên của Worksheet cần sao chép, chọn Move or Copy, trong ô 

To book, chọn new book và đánh dấu check vào ô Create a copy 

b) Click chuột phải trên tên của Worksheet cần sao chép, chọn Copy, tạo một 

workbook mới và chọn Paste 

c) Chọn Worksheet cần sao chép, chọn Copy, chọn tab File, chọn new book và đánh 

dấu check vào ô Create a copy 

d) Chọn Worksheet cần sao chép, chọn Copy, trong ô To book, chọn new book và đánh 

dấu check vào ô Create a copy 

32) Ô A1 chứa giá trị A04, tại ô B1, nhập công thức =RIGHT(A1,1)*4, kết quả của công 

thức là gì? 

a) #VALUE! 

b) 16 

c) 0 
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d) #REF! 

33) Hàm nào sau đây dùng để đếm các ô không rỗng 

a) Count 

b) Counta 

c) Countblank 

d) countif 

34) Lựa chọn nào sau đây là kết quả của công thức =ROUND(98756.678,-3) 

a) 99000 

b) 98756.000 

c) 98756 

d) 98000 

35) Cho bảng tính như hình bên. Điểm 

tổng kết bằng trung bình cộng của 

Điểm lý thuyết và Điểm thực hành 

nhưng chỉ tính nếu điểm thành phần 

>=5, ngược lại điểm tổng kết là 0, công thức nào sau đây là đáp án của yêu cầu trên. 

a) =IF(MIN(A2:B2)>=5,AVERAGE(A2:B2),0) 

b) =IF(OR(A2>=5,B2>=5),AVERAGE(A2:B2),0) 

c) =IF(OR(A2<=5,B2<=5),0, AVERAGE(A2:B2)) 

d) =IF(AND(A2>=5,B2>=5), 0, AVERAGE(A2:B2)) 

36) Ô A1 chứa chuỗi “Khoa Công Nghệ Thông Tin”. Hãy cho biết kết quả của công thức 

=RIGHT(LEFT(A1,14),9)  

a) Công Nghệ 

b) Thông tin  

c) Khoa Công Nghệ 

d) #VALUE! 

37) Ô A1 chứa chuỗi “Đại Học Công Nghiệp TP.HCM”. Hãy cho biết lựa chọn nào sau đây 

tương đương với công thức =MID(A1,9,11)  

a) =LEFT(RIGHT(A1,18),11) 
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b) =RIGHT(LEFT(A1,19),11) 

c) =MID(LEFT(A1,19),9,11) 

d) Tất cả các lựa chọn là tương đương 

38) Tổ hợp phím nào sau đây dùng để định dạng một số ở dạng %  

a) Ctrl + Shift + % 

b) Ctrl + % 

c) Shift + % 

d) Ctrl + Alt + % 

39) Nhập đối số thứ 2 của hàm Weekday là 2, nếu kết quả của hàm là 3, hãy cho biết đó là 

ngày thứ mấy trong tuần? 

a) Thứ hai 

b) Thứ ba 

c) Thứ tư 

d) Thứ năm 

40) Cho bảng tính như hình bên. Công thức nào 

sau đây dùng để điền tên hàng trong ô B2, 

sau đó sao chép cho các ô B3:B7 

a) =VLOOKUP(RIGHT(A2,2)*1,$D$3:$E$5,2,0) 

b) =VLOOKUP(RIGHT(A2,2),$D$3:$E$5,2,0) 

c) =VLOOKUP(RIGHT(A2,2),D3:E5,2,0) 

d) =HLOOKUP(RIGHT(A2,2),$D$3:$E$5,2,0) 

41) Cho bảng tính như hình bên. Công thức nào sau 

đây dùng để điền dữ liệu trong ô B2 và sau đó sao 

chép cho các ô B3:B8 

a) =VLOOKUP(A2,$D$2:$E$6,2,1) 

b) =VLOOKUP(A2,$D$2:$E$6,2,0) 

c) =VLOOKUP(A2,$D$2:$E$6,2) 

d) =VLOOKUP(A2,D2:E6,2,1) 
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42) Trong hộp thoại Format cells, thiết lập định dạng cho dữ liệu kiểu số sao cho khi nhập 

giá trị 011122333, kết quả hiển thị là 011-12-2333, mẫu định dạng nào sau đây là đúng 

a) 000-00-0000 

b) ###-##-#### 

c) @@@-@@-@@@@ 

d) $$$-$$-$$$$ 

43) Cho bảng tính như hình bên cạnh. Công thức nào sau đây 

dùng để đếm số thí sinh có điểm >=8 

a) =COUNTIF(A2:A8,">=8") 

b) =COUNTIF(A2:A8,>=8) 

c) =COUNTIF(A2:A8,’>=8’) 

d) =COUNTA(A2:A8,">=8") 

44) Cho bảng tính như hình bên. Công thức nào sau đây dùng để đếm số thí sinh có điểm 

cao hơn điểm trung bình của cả lớp 

a) =COUNTIF(A2:A8,">"&AVERAGE(A2:A8)) 

b) =COUNTIF(A2:A8,">"& "AVERAGE(A2:A8) ") 

c) =COUNTIF(A2:A8,">AVERAGE(A2:A8) ") 

d) =COUNTIF(A2:A8,>&AVERAGE(A2:A8)) 

45) Cách nào sau đây dùng để hiệu chỉnh độ rộng của cột vừa 

với dữ liệu trong ô 

a) Đặt trỏ trong cột cần hiệu chỉnh, click nút Format trong nhóm lệnh Cells, chọn 

Autofit column whidth 

b) Click chuột phải trên cột cần hiệu chỉnh, chọn Autofit column whidth 

c) Chọn cột cần hiệu chỉnh, double click 

d) Đặt trỏ tại vị trí bất kỳ trong cột cần hiệu chỉnh, double click 

46) Ô A1 và B1 lần lượt chứa các giá trị 8 và 6, lựa chọn nào sau đây là kết quả của công 

thức =IF(A1>B1,A1-B1,B1-A1) 

a) 2 

b) 4 
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c) 6 

d) 8 

47) Ô A1 và B1 lần lượt chứa các giá trị 8 và 6, lựa chọn nào sau đây là kết quả của công 

thức =A1*B1/IF(A1>B1,A1-B1,B1-A1) 

a) 24 

b) 12 

c) 18 

d) 48 

48) Dùng chức năng Conditional Formatting tô màu các ô chứa giá trị <5, Rule nào sau đây 

phù hợp với yêu cầu trên 

a) Format only cells that contain 

b) Format only top or bottom ranked values 

c) Format only values that are above or below average 

d) Use a formula to detemine which cells to format 

49) Dùng chức năng Filter lọc ra các nhân viên có tên bắt đầu bằng ký tự H, lựa chọn nào 

sau đây thực hiện yêu cầu trên? 

a) Click nút bên phải cột Tên nhân viên, chọn Text Filters -> Begin with, trong hộp 

thoại Custom Auto filter, nhập ký tự H, ok 

b) Click phải cột Tên nhân viên, chọn Text Filters -> Begin with, nhập ký tự H 

c) Click phải cột Tên nhân viên, chọn Text Filters -> trong hộp thoại Custom Auto 

filter, nhập ký tự H* 

d) Click phải cột Tên nhân viên, chọn Text Filters -> Begin with, nhập ký tự H* 

50) Dùng chức năng Filter lọc ra những thí sinh có điểm >=8, thao tác nào sau đây là đúng? 

a) Click nút bên phải cột điểm, chọn Number filter-> greater than or equal to, trong 

hộp thoại Custom Auto filter, nhập giá trị so sánh là 8, ok 

b) Click chuột phải trong cột điểm Number filter-> greater than or equal to, trong hộp 

thoại Custom Auto filter, nhập giá trị so sánh là 8, ok 

c) Click nút bên phải cột điểm, chọn auto filter-> trong hộp thoại Custom Auto filter, 

nhập giá trị so sánh là 8, ok 
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d) Click nút bên phải cột điểm, chọn Number filter-> less than or equal to, trong hộp 

thoại Custom Auto filter, nhập giá trị so sánh là 8, ok 

51) Tổ hợp phím nào sau đây dùng để mở hộp thoại Find and Replace với tab Replace được 

kích hoạt 

a) Ctrl + F 

b) Ctrl + H 

c) Ctrl + R 

d) Ctrl + I 

52) Tổ hợp phím nào sau đây dùng để chèn chú thích (comment) tại ô hiện hành 

a) Ctrl + F2 

b) Shift + F2 

c) Alt + F2 

d) Ctrl + Shift + F2 

53) Thao tác nào bắt buộc thực hiện trước khi thực hiện chức năng Subtotal 

a) Sắp xếp (Sort) 

b) Lọc (Filter) 

c) Tạo nhóm (Group) 

d) Không có thao tác bắt buộc thực hiện trước 

54) Bảng điều kiện được sử dụng để lọc dữ liệu bằng chức 

năng Advanced Filter có dạng như hình tương ứng với 

yêu cầu nào sau đây? 

a) Lọc ra các thí sinh thuộc trường Năng khiếu và những thí sinh thi môn Toán 

b) Lọc ra các thí sinh thuộc trường Năng khiếu thi môn Toán 

c) Lọc ra các thí sinh thuộc trường Năng khiếu không thi môn Toán 

d) Lọc ra các thí sinh thi môn Toán không thuộc trường Năng khiếu 

55) Tổ hợp phím nào dùng để tạo biểu đồ biểu diễn dữ liệu trong dãy ô đang được chọn 

a) Alt + F1 

b) Shift + F1 

c) Ctrl + F1 
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d) Ctrl + Shift + F1 

56) Tổ hợp phím nào dùng để ẩn/hiện thanh Ribbon trong Excel 

a) Alt + F1 

b) Shift + F1 

c) Ctrl + F1 

d) Ctrl + Shift + F1 

57) Thông báo lỗi nào cho biết khi một số có định dạng rộng hơn độ rộng của một ô? 

a) #### 

b) #Div/0! 

c) #div@ 

d) #REF! 

58) Khi cần biểu diễn xu hướng doanh thu của nhân viên bán hàng trong mỗi tháng, biểu 

đồ nào là phù hợp nhất? 

a) Pie chart 

b) Row chart  

c) Line chart  

d) Column chart 

59) Để giữ cột tiêu đề hoặc dòng tiêu đề ở vị trí cố định sao cho chúng không di chuyển khi 

cuộn bảng tính, lệnh nào sau đây sẽ được sử dụng 

a) Unfreeze Panes  

b) Freeze Panes  

c) Split 

d) Hold titles 

60) Khi sao chép một công thức 

a) Excel xóa bản gốc của công thức 

b) Excel chỉnh sửa các ô tham chiếu trong công thức mới được sao chép 

c) Excel sẽ điều chỉnh các ô tham chiếu tuyệt đối 

d) Excel không điều chỉnh các ô tham chiếu tương đối 

61) Lựa chọn nào sau đây không là dữ liệu hợp lệ trong excel 
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a) Number 

b) Character 

c) Label 

d) Date/Time 

62) Lệnh nào dùng để tách cửa sổ làm việc của Excel thành hai cửa sổ 

a) Chọn tab View-> Split 

b) Chọn tab View -> Window Split 

c) Chọn tab Home -> Split 

d) Chọn tab ReView-> Split 

63) Ký hiệu nào sau đây dùng để nối chuỗi? 

a) ‘ 

b) ! 

c) # 

d) & 

64) Trong excel, có thực hiện phép tính tổng của dãy nhiều ô nằm liền kề nhau một cách tự 

động bằng cách chọn chức năng nào sau đây? 

a) AutoFill 

b) Auto correct 

c) Auto sum 

d) Auto format 

65) Hàm nào sau đây dùng để lấy phần dư của phép chia 

a) Round 

b) Fact 

c) Mod 

d) Div 

66) Thiết lập định dạng cho ô chứa  dữ liệu số 5436.8 có dạng #,##0.00, kết quả hiển thị là 

gì? 

a) 5,430.00 

b) 5,436.80 



c) 5,436.8 

d) 5,437.00 

67) Hàm nào trả về ngày và giờ hiện hành của máy? 

a) Date() 

b) Today() 

c) Now() 

d) Time() 

68)  Hàm COUNT() dùng để đếm___________ 

a) Các ô chứa dữ liệu số 

b) Các ô chứa dữ liệu text 

c) Các ô rỗng 

d) Các ô không rỗng 

69) Tổ hợp phím nào dùng để chọn một cột 

a) Ctrl+Space Bar 

b) Ctrl+Page Up 

c) Ctrl+Enter 

d) Ctrl+Shift +Enter 

70) Excel hiển thị địa chỉ của ô hiện hành trong __________ 

a) Formula bar 

b) Status Bar 

c) Name Box 

d) Title Bar 

71) Phím tắt nào dùng để tạo biểu đồ biểu diễn khối dữ liệu đang được chọn, biểu đồ được 

tạo trong một sheet mới 

a) F2 

b) F4 

c) F8 

d) F11 

72) Công thức nào sau đây dùng để tìm giá trị cao nhất trong một dãy giá trị: 
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a) MAX(B1:B3) 

b) MAXIMUM (B1:B3) 

c) HIGH (B1:B3) 

d) HIGHEST(B1:B3) 

73) Trong excel, tổ hợp phím nào sau đây dùng để chèn ngày hiện hành? 

a) Ctrl + D 

b) Ctrl + T 

c) Ctrl + ; 

d) Ctrl + / 

74) Nếu nhập 4/6 vào một ô trong bảng tính excel, không có bất kỳ định dạng nào thì excel 

xem đây là kiểu dữ liệu gì? 

a) Phân số  

b) Số 

c) Text 

d) Ngày  

75) Ô A1 chứa chuỗi “what you see”, B1 chứa chuỗi “what you get”, công thức nào sau 

đây trả về chuỗi “what you see is what you get” 

a) A1&”is”&B1 

b) A1+” is ”+B1 

c) A1#”is”#B1 

d) A1$”is”$B1 

76) Tổ hợp phím nào dùng để ẩn một dòng trong bảng tính 

a) Ctrl + H 

b) Ctrl + R 

c) Ctrl + 9 

d) Ctrl + - 

77) Lựa chọn giúp người dùng định dạng tất cả các số âm có dạng đậm, màu đỏ, gọi là  

a) Conditional Formatting 

b) Compare Formatting 
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c) Negative Formatting 

d) Zero Formatting 

78) Trong Excel, khi nhập một số vào ô, mặc định số hiển thị ở vị trí nào trong ô? 

a) Left  

b) Right  

c) Center  

d) Justify  

79) Trong ô C1, nhập công thức =A1=B1, kết quả là gì? 

a) True 

b) False 

c) #VALUE! 

d) #REFT! 

80) Lựa chọn nào sau đây là một địa chỉ ô trong bảng tính excel 

a) 11 25 

b) 911 

c) 41A 

d) A21 

 



1) Trong hệ thống máy tính, thiết bị nào sau đây là thiết bị nhập / xuất cơ bản: 

a) Bàn phím, Màn hình 

b) Bàn phím, Chuột, Máy chiếu 

c) Máy chiếu, Máy scan 

d) Máy In, Máy Scan, Máy Chiếu 

2) Các thành phần cơ bản của một thùng máy tính bao gồm: 

a) Vỏ thùng, CPU, Ram, Mainboard 

b) CPU, Ram, MainBoard, HDD, Power 

c) CPU, Ram, DVD- Rom, MainBoard, Power 

d) Vỏ máy, CPU, Ram, HDD, MainBoard, Power 

3) Trong một hệ thống máy tính cá nhân, các thiết bị nào được liệt kê dưới đây là thiết bị 

nhập/ xuất không chuẩn 

a) Bàn phím, Mouse, Màn hình 

b) Bàn phím, Máy Chiếu, Máy In 

c) Máy in, Máy Chiếu, Máy Scan, Mouse 

d) Máy Chiếu, Máy Scan, Máy quét từ 

4) Trong một máy tính, các thiết bị nào sao đây có thể gắn trực tiếp lên thùng máy khi 

đang hoạt động 

a) USB, HDD, Ram, Thẻ Nhớ 

b) USB, Thẻ Nhớ, DVD,Ram 

c) Bàn phím, USB, Mouse, Ổ cứng di động 

d) Tất cả đều sai 

5) Nút F2 trên bàn phím có công dụng gì? 

a) Thoát khỏi trạng thái copy hàm trong excel 

b) Xóa kí tự đầu câu 

c) Đổi tên tập tin  

d) Đổi tên đối tượng được chọn 

6) Nút F6 trên bàn phím dùng để làm gì? 

a) Xóa kí tự được chọn trước 



b) Truy cập thanh địa chỉ trên trình duyệt web 

c) Truy cập thanh địa chỉ trên cửa sổ hiện hành 

d) Di chuyển con trỏ trong thanh địa chỉ và dùng để bôi đen thanh địa chỉ trên các trình 

duyệt 

7) Trong hệ thống bàn phím cơ bản, nút F12 có công dụng nào sau đây? 

a) Đổi tên file 

b) Đổi tên thư mục 

c) Đổi tên file và thư mục 

d) Lưu tập tin với tên mới khác tên ban đầu của một file 

8) Công dụng cơ bản của nút chuột trái là gì? 

a) Chọn đối tượng 

b) Xóa đối tượng 

c) Chọn một hoặc nhiều đối tượng 

d) Xóa một hoặc nhiều đối tượng 

9) Trong hệ thống máy tính, các thành phần nào sau đây được xem là bộ nhớ chính? 

a) Ram, Rom 

b) Ram, HDD 

c) Rom, USB 

d) Ram, Rom, HDD 

10) Bộ nhớ thứ cấp bao gồm các thiết bị nào dưới đây:  

a) HDD, DVD, CD, Ram 

b) HDD, DVD, Thẻ Nhớ, Băng Từ 

c) HDD, SSD, Rom, Ram 

d) Ram, Rom, DVD, USB 

11) Phát biểu nào sau đây là sai khi nói về bộ nhớ chính! 

a) Bộ nhớ chính là bộ nhớ quan trọng nhất của máy tính. 

b) Bộ nhớ chính không thể thay đổi trong suốt thời gian máy tính hoạt động 

c) Bộ nhớ chính có thể thay đổi được trong lúc máy đang hoạt động 

d)  Cả a và b đều đúng 



12) Có bao nhiêu loại bộ nhớ chính 

a) 1 

b) 2 

c) 3 

d) 4 

13) Khái niệm nào sau đây là đúng khi nói về hệ điều hành? 

a) Hệ điều hành là một phần mềm hệ thống quan trọng  

b) Hệ điều hành là phần mềm hệ thống dùng để điều khiển toàn bộ hoạt động của máy 

tính trong suốt thời gian máy tính hoạt động 

c) Hệ điều hành là phần mềm hệ thống dùng để điều khiển toàn bộ cấu trúc của máy 

tính 

d) Tất cả đều sai 

14) Khái niệm cơ bản về phần mềm? 

a) Phần mềm là chương trình máy tính khi được thực thi mang hiệu quả và chức năng 

mong muốn 

b) Phần mềm là chương trình máy tính khi thực thi mang lại kết quả mong muốn 

c) Phần mềm là chương trình máy tính được thực thi mang lại một chương trình khác 

d) Tất cả ý trên đều sai. 

15) Khái niệm cơ bản về phần mềm ứng dụng? 

a) Phần mềm ứng dụng là phần mềm dùng để tạo ra ứng dụng 

b) Phần mềm ứng dụng là phần mềm phục vụ cho các công việc khác nhau trong cuộc 

sống và công việc hằng ngày. 

c) Phần mềm ứng dụng là công cụ 

d) Phần mềm ứng dụng là một phần mềm hệ thống quan trọng 

16) Bộ xử lý quan trọng nhất của máy tính là gì ? 

a) Ram 

b) Chíp cầu Bắc 

c) Chíp cầu Nam 

d) CPU 



17) Trong CPU có các thành phần nào? 

a) CPU, CU, ALU 

b) CU, ALU 

c) CLU, ALU 

d) RAM, CU, ALU 

18) Khi hệ thống máy tính khởi động, thiết bị được truy xuất đầu tiên là? 

a) ROM 

b) RAM 

c) Ổ cứng 

d) CPU 

19) Trong các hoạt động của máy tính thì hoạt động nào là quan trọng nhất? 

a) Xử lý thông tin 

b) Lưu trữ thông tin 

c) Trao đổi thông tin 

d) Truyền thông tin 

20) Hệ điều hành máy tính tương tác với người dùng thông qua? 

a) Giao diện đồ họa 

b) Thiết bị nhập xuất 

c) Giao diện dòng lệnh 

d) Bàn phím 

21) Nguyên lý hoạt động của CPU 

a) Nhận lệnh, giải mã lệnh, thực hiện lệnh. 

b) Nhận lệnh, giải mã lệnh, nhận toán hạng, thực hiện lệnh, ngắt. 

c) Nhận lệnh, giải mã lệnh, thực hiện lệnh, ngắt. 

d) Nhận lệnh, giải mã lệnh, nhận toán hạng, thực hiện lệnh, cất toán hạng, ngắt. 

22) Tốc độ truy xuất của máy tính phụ thuộc vào 

a) Ram 

b) ROM 

c) CPU 



d) GPU 

23) Ngôn ngữ để CPU có thể xử lý thông tin có dạng: 

a) Thập phân 

b) Bát phân 

c) Nhị Phân 

d) Thập lục phân 

24) Sự khác nhau giữa Ram và Rom 

a) Ram là bộ nhớ truy xuất ngẫu nhiên, Rom là bộ nhớ chỉ để đọc 

b) Ram là bộ nhớ chỉ để đọc, Rom là bộ nhớ truy xuất ngẫu nhiên 

c) Ram là bộ nhớ vừa đọc vừa ghi, Rom là bộ nhớ chỉ để đọc 

d) Ram là bộ nhớ để đọc, Rom là bộ nhớ vừa đọc vừa ghi 

25) Bộ phận chuyển đổi sang ngôn ngữ máy để CPU có thể xử lý là? 

a) Rom 

b) Chipset (North Bridge) 

c) Ram 

d) Mainboard 

26) Chức năng của hệ điều hành là gì? 

a) Quản lý quá trình 

b) Quản lý bộ nhớ 

c) Quản lý hệ thống lưu trữ 

d) Tất cả đều đúng 

27) Cổng PS/2 có màu xanh lá được kết nối với thiết bị nào sau đây? 

a) Chuột 

b) Scanner  

c) Bàn phím  

d) Modem 

28) Vi xử lý thế hệ Core 2 Duo của Intel được tích hợp bao nhiêu nhân xử lí? 

a) 1  

b) 2  



c) 3  

d) 4 

29) Tốc độ 1x chuẩn của ổ đĩa CD-ROM thường có giá trị là: 

a) 1024 KBps 

b) 150 KBps  

c) 1500 KBps  

d) 2048 KBps 

30) Máy Scanner được kết nối với máy tính thông qua cổng nào sau đây?  

a) USB 

b) RJ 45 

c) LPT  

d) RJ 11 

31) Đơn vị đo lường thông tin cơ bản của máy tính là gì? 

a) Byte 

b) Kilo Byte 

c) Mega Byte 

d) Giga Byte 

32) Có bao nhiêu loại đơn vị đo thông tin cơ bản? 

a) 2 

b) 3 

c) 4 

d) 1 

33) Trong các đơn vị đo lường thông tin cơ bản, nhà sản xuất quy định 1KB bằng bao nhiêu 

B? 

a) 1024 B 

b) 1000 B 

c) 2048 B 

d) 948 B 

34) Hãy cho biết kết quả của phép toán 1MB = ? GB? 



a) 1024 

b) 1/ 1024 

c) 1/2048 

d) Tất cả đều sai 

35) Phát biểu nào sau đây là đúng khi nó về đơn vị đo lường cơ bản ? 

a) Đơn vị đo lường thông tin cơ bản chỉ dùng đo dung lượng của đĩa cứng 

b) Đơn vị đo lường thông tin cơ bản chi đo lường trong lượng của máy tính 

c) Đơn vị đo lường thông tin cơ bản là đơn vị do dung lượng dữ liệu lưu trữ tỏng máy 

tính 

d) Tất cả đều sai 

36) Khái niệm nào sau đây là đúng khi nói về đơn vị đo lường thông tin cơ bản? 

a) Đơn vị nhỏ nhất trong máy tính là Bit 

b) Đơn vị nhỏ nhất trong máy tính là Byte 

c) Không có đơn vị nhỏ nhất trong máy tính 

d) Tất cả đều sai 

37) Thông tin lưu trữ trong máy tính dưới dạng gì? 

a) Thập phân  

b) Bát phân 

c) Nhị phân  

d) Thập lục phân 

38) Trong các đơn vị đo thông tin sau đây. Đơn vị nào là nhỏ nhất? 

a) Byte 

b) KB 

c) MB 

d) TB 

39) Các thiết bị nào sau đây sử dụng đơn vị đo thông tin cơ bản để đánh giá? 

a) Đĩa cứng 

b) CPU 

c) Mainboard  



d) Màn hình 

40) Các thiết bị nào dưới không sử dụng đơn vị đo lường thông tin cở bản để đánh giá 

a) Rom, Ram, CPU 

b) HDD, SSD, DVD 

c) FDD, DVD, USB 

d) Tất cả đều sai 

41) Hãy cho biết phát biểu nào sao đây là đúng khi nói về đơn vị đo lường thông tin cơ bản? 

a) Đơn vị lưu trữ  thông tin cơ bản của máy tính là byte 

b) Đơn vị lưu trữ  thông tin cơ bản của máy tính là Kilo byte 

c) Đơn vị lưu trữ  thông tin cơ bản của máy tính là Mega byte 

d)  Đơn vị lưu trữ  thông tin cơ bản của máy tính là Giga byte 

42) Phát biểu nào dưới đây là đúng? 

a) Nhà sản xuất  quy định 1 MB = 1000KB 

b) Nhà sản xuất chỉ sản xuất các sản phầm theo quy ước 1MB = 1024 KB 

c) Nhà sản xuất không sản xuất theo quy định của đơn vị thông tin cơ bản 

d) Tất cả đều sai 

43) Hãy cho biết phép so sánh nào sau đây là đúng? 

a) 1KB = 1024 GB 

b) 1KB = 210 MB 

c) 1KB = 210 B 

d) 1KB = 2-10 MB 

44) Hãy cho biết phép toán so sánh nào sau đây là sai? 

a) 1TB = 1024 GB 

b) 1TB = 210  GB 

c) 1TB = 240 B 

d) 1TB = 250 B  

45) Lựa chọn nào sau đây là kết quả của phép toán “100KB + 100MB”? 

a) 101 MB 

b) 110 MB 



c) 100,1 MB 

d) 102500 KB 

46) Lựa chọn nào sau đây là kết quả của phép toán “ 1GB + 1MB” ? 

a) 101 GB 

b) 100 GB 

c) 100,1 GB 

d) 1025 MB 

47) Lựa chọn nào sau đây là đúng? 

a) 1 KB = 1023 B 

b) 1KB = 1025 B 

c) 1 KB = 1024 B 

d) 1 KB = 1027 B 

48) Lựa chọn nào sau đây là sai? 

a) 1MB = 1024 KB 

b) 1MB = 220 B 

c) 1 MB = 1/1024 GB 

d) 1 MB = 1000 KB 

49)  Lựa chọn nào sau đây là đúng? 

a) 1 TB = 210 GB 

b) 1 TB = 210 MB 

c) 1 TB = 210 KB 

d) 1 TB = 210 B 

50) Lựa chọn nào sau đây là đúng? 

a) 1 TB = 210 B 

b) 1 TB = 220 B 

c) 1 TB = 230 B 

d) 1 TB = 240 B 

 



1) Những định dạng file nào sau đây có thể thêm vào trong PowerPoint? 

a) .jpg  

b) .giv  

c) .wav  

d) Tất cả đều đúng 

2) Để kết thúc việc trình diễn trong PowerPoint, ta bấm: 

a) Phím 10            

b) Phím ESC            

c) Phím Enter                

d) Phím Delete 

3) Những định dạng file âm thanh nào sau đây có thể thêm vào PowerPoint? 

a) .wav và .mid  

b) .wav và .gif  

c) .wav và .jpg  

d) .jpg và .gif  

4) Khi đang làm việc với PowerPoint, để chèn thêm một Slide mới, ta thực hiện: 

a) Edit - New Slide 

b) File - New Slide 

c) Slide Show - New Slide 

d) Insert - New Slide 

5) Khi đang làm việc với PowerPoint, muốn xóa bỏ một Slide, ta thực hiện 

a) Insert  - Delete Slide 

b) Click chuột phải lên slide cần xóa - Delete Slide 

c) Design - Delete Slide 

d) Slide Show - Delete Slide 

6) Sử dụng hiệu ứng motion path khi 

a) Để bắt đầu quá trình trình chiếu 

b) Muốn thực hiện trình chiếu nâng cao 

c) Muốn di chuyển các đối tượng trong một slide 



d) Tất cả đều đúng 

7) Trong chương trình MS PowerPoint, chức năng Design/Themes dùng để làm gì? 

a) Định dạng giao diện của slide 

b) Định dạng hiệu ứng lật trang 

c) Định đạng hiệu ứng cho các đối tượng trên slide 

d) Tất cả đều sai 

8) Trong chương trình MS PowerPoint, chức năng Transitions dùng để làm gì? 

a) Định dạng hiệu ứng chuyển trang cho các slide 

b) Định dạng giao diện cho slide 

c) Định dạng hiệu ứng cho các đối tượng trên slide 

d) Định dạng trang in cho slide 

9) Phát biểu nào sau đây đúng? 

a) Trong chương trình MS PowerPoint, chúng ta có thể thiết lập thời gian chờ, âm 

thanh cho các hiệu ứng lật trang hay các hiệu ứng của các đối tượng 

b) Trong chương trình MS PowerPoint, chúng ta chỉ có thể click chuột để chuyển đổi 

cho các hiệu ứng lật trang hay các hiệu ứng của các đối tượng 

c) Tất cả đều sai 

d) Tất cả đều đúng. 

10) Trong chương trình MS PowerPoint, chức năng Custom Animation dùng để làm gì? 

a) Tạo hiệu ứng cho các đối tượng trên slide. 

b) Dùng để tạo hiệu ứng lật trang slide 

c) Dùng để thiết lập giao diện cho slide. 

d) Tạo các thiết lập định dạng cho hình ảnh trong slide 

11) Phát biểu nào sau đây đúng? 

a) Trong chương trình MS PowerPoint, chúng ta có thể thiết lập các tùy chọn cho 

một slide hay một tập slide cùng một lúc. 

b) Trong chương trình MS PowerPoint, chúng ta chỉ có thể thiết lập các tùy chọn cho 

một slide và không thể thiết lập cho một tập slide cùng một lúc. 

c) Trong một trình chiếu chỉ tạo được một slide master. 



d) Trong một trình chiếu chỉ có thể áp dụng một template. 

12) Khi đang làm việc với PowerPoint, muốn thiết lập lại bố cục (trình bày về văn bản, 

hình ảnh, biểu đồ,...) của Slide, ta thực hiện 

a) Home - Slide -Layout... 

b) View - Slide Layout... 

c) Insert - Slide Layout...    

d) File - Slide Layout... 

13) Khi đang làm việc với PowerPoint, muốn trình diễn tài liệu được soạn thảo, ta thực 

hiện: 

a) File - View Show    

b) View - View Show 

c) Slide Show – Start Slide Show… 

d) Tools - View Show    

14) Khi đang làm việc với PowerPoint, để chèn thêm một Slide mới, ta thực hiện: 

a) Edit - New Slide  

b) Design - New Slide 

c) Slide Show - New Slide  

d) Insert - New Slide 

15) Trong PowerPonit, để thay đổi thiết kế của Slide, ta thực hiện 

a) Design – Themes… 

b) Review  - Slide Design... 

c) Insert - Slide Design...  

d) Slide Show - Slide Design... 

16) Để trình diễn một Slide trong PowerPoint, ta bấm: 

a) Phím F5  

b) Phím F3 

c) Phím F1 

d) Phím F10 



17) Khi đang trình chiếu một tập tin PowerPoint, muốn kết thúc phiên trình diễn, ta thực 

hiện: 

a) Click phải chuột, rồi chọn Exit 

b) Click phải chuột, rồi chọn Return 

c) Click phải chuột, rồi chọn End Show  

d) Click phải chuột, rồi chọn Screen 

18) Cách nào sau đây thực hiện thiết lập hiệu ứng cho các đối tượng trên slide? 

a) Chọn tab Insert, chọn lệnh Custom Animation, click Add Effect 

b) Chọn tab Home,  chọn lệnh Custom Animation, click Add Effect 

c) Chọn tab View, chọn lệnh Custom Animation, click Add Effect 

d) Chọn tab Animation, chọn lệnh Advanced Animation, click Add Animation, chọn 

Add Effect 

19) Để xóa hiệu ứng trên một đối tượng, chọn đối tượng cần xóa hiệu ứng,  và thực hiện 

thao tác nào sau đây? 

a) Click nút Animation Pane trong nhóm Advanced Animation trên tab Animation, 

chọn hiệu ứng cần xóa, click Remove 

b) Click phải trên đối tượng click Remove 

c) Nhấn phím Delete 

d) Xóa đối tượng đã gán hiệu ứng chèn lại đối tượng khác 

20) Kiểu View nào chỉ hiển thị một slide duy nhất khi soạn thảo 

a) Normal view 

b) Outline view 

c) Slide sorter 

d) Notes page 

21) Để thay đổi màu nền của các slide, ta thực hiện 

a) Nhấp vào nút fill color trên thanh drawing 

b) Chọn Insert/slide design 

c) Chọn Home/objects 

d) Chọn Design – Customize – Format Background 



22) Phần mở rộng của MS power point 2013 là gì? 

a) PPTM 

b) POPX 

c) POWX 

d) PPTX 

23) Trong MS Powerpoint, loại hiệu ứng nào sau đây dùng để làm nổi bật (nhấn mạnh) 

đối tượng khi trình chiếu: 

a) Entrance 

b) Motion Paths 

c) Exit 

d) Emphasis 

24) Trong MS Powerpoint, loại hiệu ứng nào sau đây thường dùng để gán cho các đối 

tượng khi bắt đầu trình chiếu: 

a) Entrance 

b) Motion Paths 

c) Exit 

d) Emphasis 

25) Trong MS Powerpoint, loại hiệu ứng nào sau đây dùng để di chuyển đối tượng khi 

trình chiếu: 

a) Emphasis  

b) Exit 

c) Entrance 

d) Motion Paths 

26) Trong MS Powerpoint, lựa chọn nào sau đây dùng để tạo hiệu ứng hoạt hình cho các 

đối tượng 

a) Tab Home / Slide Transition / Animation 

b) Tab Transition / Animation 

c) Tab Animations / Animation 

d) Tab Slide show / Custom Animation 



27) Trong MS Powerpoint, để sao chép 1 slide trong tập tin trình diễn (Presentation), ta 

chọn slide rồi thực hiện: 

a) Nhấn tổ hợp phím Ctrl-C 

b) Tab Home / Clipboard / Copy 

c) Click chuột phải lên slide / Copy 

d) Tất cả đều đúng 

28) Khi sử dụng Microsoft PowerPoint để trình diễn, muốn chấm dứt chế độ trình diễn ta 

thực hiện: 

a) Nhấn phím Break 

b) Nhấn phím  Esc 

c) Nhấn phím Space Bar 

d) Nhấn phím Enter 

29) Khi sử dụng Microsoft PowerPoint để trình diễn, muốn trở lại slide trước đó ta phải 

ấn phím 

a) PgUp 

b) Enter 

c) PgDn 

d) Esc 

30) Trong MS PowerPoint, để slide tự động gọi slide kế tiếp sau thời gian 3 giây, ta chọn 

tất cả các slide, sau đó thực hiện 

a) Slide show / Timing / Thiết lập Duration là 3s 

b) Slide show / Thiết lập Duration là 3s 

c) Transition / Timing / Thiết lập Duration là 3s 

d) Design / Thiết lập Duration là 3s 

31) Địa chỉ URL một website có thể có______________ 

a) Nhiều hơn một địa chỉ 

b) Chỉ duy nhất một địa chỉ 

c) Chỉ duy nhất một web browser 

d) Chỉ duy nhất một IP  



32) Chọn phát biểu đúng về nhất về Internet Protocol. Là … 

a) Các công ty quản lý Internet 

b) Các địa chỉ trang web trên Internet 

c) Nhà quản lý Internet 

d) Giao thức kết nối internet 

33) Chọn phát biểu đúng về địa chỉ IP 

a) Địa chỉ IP dùng để xác định đối tượng nhận và gửi thông tin trên Internet. 

b) Địa chỉ IP bao gồm 32 bit được chia thành 4 nhóm, mỗi nhóm cách nhau bằng dấu 

chấm (.). 

c) Câu a và b đều đúng. 

d) Câu a và b đều sai. 

34) Các nhà cung cấp dịch vụ Internet được viết là 

a) IIS 

b) IAP 

c) TCP 

d) ISP 

35) HTTP là gì? 

a) Là giao thức truyền siêu văn bản. 

b) Là ngôn ngữ để soạn thảo nội dung các trang Web. 

c) Là tên của trang web. 

d) Là địa chỉ của trang Web. 

36) TCP/IP được viết tắt từ: 

a) Transmission Control Protocol / Internet Protocol. 

b) Transmission Control Panel / Internet Protocol. 

c) Transaction Control Prototype / Internet Prototype. 

d) Transmission Control Protocol / Internet Prototype. 

37) Chọn phát biểu đúng về Email 

a) Là phương thức truyền tập tin từ máy này đến máy khác trên mạng. 

b) Là dịch vụ cho phép ta truy cập đến hệ thống máy tính khác trên mạng. 



c) Là dịch vụ cho phép ta gởi và nhận thư điện tử. 

d) Là hình thức hội thoại trực tiếp trên Internet. 

38) Chọn một địa chỉ Email đúng cú pháp? 

a) cuibap.com.vn 

b) cuibap.email.com 

c) cuibap@abcd.com 

d) cuibap.@abcd.vn 

39) Dung lượng lưu trử tối đa của một tài khoản email không tính phí google là: 

a) 15GB 

b) 4GB 

c) 1024MB 

d) 1TB  

40) Chọn phát biểu đúng về Email 

a) Là phương thức truyền tập tin từ máy này đến máy khác trên mạng. 

b) Là dịch vụ cho phép ta truy cập đến hệ thống máy tính khác trên mạng. 

c) Là dịch vụ cho phép ta gởi và nhận thư điện tử. 

d) Là hình thức hội thoại trực tiếp trên Internet. 

41) Phần mềm nào sau đây có thể cho phép nhận và gủi Email 

a) Microsoft File Explorer 

b) Microsoft Access 

c) Windows Fax and Scan 

d) Microsoft Outlook 

42) Tính năng attach file trong Email giúp ta có thể… 

a) Xóa virus ra khỏi Email 

b) Đính kèm file khi gửi Email 

c) Xóa các file đính kèm lỗi 

d) Đính kèm thư mục 

43) Khi nhận được một email trong đó có nhiều người cùng nhận, muốn trả lời tất cả bằng 

cách 



a) Forward 

b) Reply 

c) Forward All 

d) Reply All 

44) Khi nhận được một email muốn gửi email cho một người khác bằng cách 

a) Forward 

b) Reply 

c) Forward All 

d) Reply All 

45) Chọn phát biểu không sai về tính năng attach file trong Email 

a) Đính kèm <3 file (text, pic, xlsx), dung lượng <5MB 

b) Đính kèm tất cả các file và thư mục 

c) Đính kèm <3 file, dung lượng >100MB 

d) Đính kèm tất cả các file và thư mục 

46) Quá trình attach file các file từ một máy tính lên email  

a) Uploading  

b) Forwarding 

c) FTP 

d) Downloading 

47) Tính năng Bcc khi gửi email cho nhiều người 

a) Danh sách Bcc là những người không được nhận 

b) Những người nhận email không thể trả lời email 

c) Người nhật không biết những được nhận 

d) Tất cả đều sai 

48) Chương trình dùng để xem nội dung các trang web được gọi là: 

a) Bộ soạn thảo nội dung web 

b) Phần mềm tiện ích 

c) Phần mềm hệ thống 

d) Trình duyệt web 



49) Nút Forward trên thanh công cụ của trình duyệt Internet Explorer dùng để: 

a) Đi đến cửa sổ kế tiếp 

b) Đi đến trang web tiếp theo trong các trang web đã duyệt qua 

c) Đi đến trang web cuối cùng được mở 

d) Quay lại cửa sổ trước đó 

50) Nút Back trên các trình duyệt Web dùngđể? 

a) Quay trở lại trang Web trước đó 

b) Quay trở lại cửa sổ trướcđó 

c) Quay trở lại màn hình trướcđó 

d) Đi đến trang Web tiếp theo 

51) Muốn lưu trữ các địa chỉ yêu thích Web (Browser) Internet Explorer, ta sử dụng chức 

năng: 

a) Add link 

b) Add Bookmark 

c) Add to Favorites 

d) Organize Favorites 

52) Tính năng Cc và Bcc khác nhau khi gửi email cho nhiều người 

a) Cc người nhận biết những ai nhận, Bcc là những người không được nhận 

b) Bcc người nhận biết những ai nhận, Cc không biết những được nhận 

c) Cc và Bcc giống nhau. 

d) Cc người nhận biết những ai nhận, Bcc không biết những được nhận 

53) Spam là gì email? 

a) Là việc gửi hàng loạt thư email đến nhiều người 

b) Là một loại virus 

c) Là một chương trình duyệt email 

d) Là một Server email 

54) Khi gủi email mục Subject dùng để điền 

a) Trang chủ email 

b) Tiêu đề của búc thư 



c) Địa chỉ người nhận 

d) Tất cả đều đúng 

55) Trong khi soạn thảo email nếu muốn gởi kèm file chúng ta bấm vào nút 

a) send 

b) copy 

c) attach 

d) file/save 

56) Microsoft Edge là gì? Chọn câu trả lời đúng 

a) Là một Web Browser chạytrên Windows10 

b) Là một phiên bản mới của hệ điều hành Windows 

c) Là một chương trình quản trong bộ Microsoft Office 2016 

d) Tất cả đều sai. 

57) Internet Explorer ta có thể mở một trang chủ.bằng cách 

a) Ctrl+Shift+H 

b) Ctrl+Shift+Home 

c) Alt+Home 

d) Shift+Home 

58) Phần mềm nào sau đây có thể cho phép nhận và gủi Email 

a) Microsoft File Explorer 

b) Internet Explorer 

c) Microsoft Edge 

d) Câu B và C 

59) Khi nói đến giao thức mạng thuật ngữ FTP được hiểu là 

a) Giao thức truyền file 

b) Giao thức của công ty FPT Internet 

c) Fiber Transfer Port 

d) Tất cả các câu trên đều sai 

60) HTTP là giao thức ________. 

a) Tầng ứng dụng 



b) Tầng vận chuyển 

c) Tầng mạng 

d) Không có câu nào đúng 

61) Giao thức file transfer protocol được xây dựng trên kiến trúc mạng 

a) Mô hình dữ liệu trung tâm 

b) Mô hình hướng dịch vụ 

c) Mô hình Client - Server 

d) Tất cả đề đúng 

62) Quá trình chuyển các file từ một máy tính trên Internet vào máy tính của bạn được gọi 

là 

a) Uploading  

b) Forwarding 

c) FTP 

d) Downloading 

63) Trang web động là  

a) Người dùng không thể chỉnh sửa, thay đổi dữ liệu được 

b) Người dùng có thể đăng tin mới, chỉnh sửa tin và chỉnh sửa danh mục. 

c) Trang web dùng các ảnh động 

d) Tất cả đều sai 

64) Một trình duyệt web là gì? 

a) Chương trình có thể hiển thị một trang web 

b) Chương trình dùng để xem các tài liệu html 

c) Người sử dụng để truy cập vào các nguồn tài nguyên của internet 

d) Tất cả đều đúng 

65) WWW là chữ viết tắt của 

a) World Wide Web  

b) World Wide Word 

c) World Wide Wood 

d) Không có câu nào đúng 



66) Web Server là gì? 

a) Là máy chủ dùng để đặt các trang Web trên Internet. 

b) Là máy tính đang được sử dụng để xem nội dung các trang web. 

c) Là một dịch vụ của Internet. 

d) Tất cả các câu trên đều đúng. 

67) Trang chủ là gì? 

a) Là một trang web đầu tiên của một Website. 

b) Là tập hợp các trang web có liên quan đến nhau. 

c) Là địa chỉ của Website. 

d) Tất cả các câu trên đều đúng. 

68) Máy chủ dùng để đặt các trang Web trên Internet 

a) Server mail 

b) Server 

c) Web Server 

d) Work Station 

69) Phần mềm nào sau đây không phải trình duyệt Web? 

a) Microsoft Internet Explorer 

b) Mozilla Firefox 

c) Netcape 

d) Microsoft Wi-Fi 

70) URL được viết đầy đủ là 

a) Unique reference label 

b) Uniform reference label 

c) Uniform resource locator 

d) Unique resource locator 

 



1) Phím F12 dùng để mở hộp thoại________________________  

a) Save As  

b) Open 

c) Save  

d) Close 

2)  Tổ hợp phím nào dùng để mở hộp thoại Open  

a) F12 

b) Shift F12 

c) Alt + F12 

d) Ctrl + F12 

3)  Lựa chọn nào sau đây không phải là một chức năng trên thước (Ruler) 

a) Tab stop  

b) Left Indent 

c) Right Indent 

d) Center Indent 

4)  Màu nền hoặc các hiệu ứng áp dụng trên một tài liệu chỉ hiển thị trong __________ 

a) Print Layout view 

b) Reading View 

c) Print Preview 

d) Outline View 

5) Tập tin tài liệu có thể được chia thành nhiều phần với các tùy chọn về định dạng khác 

nhau, mỗi phần được gọi là gì? 

a) Page 

b) Document 

c) Section 

d) Page Setup  

6)  Borders được áp dụng cho _______________   

a) Cells 

b) Paragraph 



c) Text 

d) Cells, Text, Paragraph 

7)   Tùy chọn nào sau đây không phải là thuộc tính lề của trang?  

a)  Left 

b) Right 

c) Center 

d) Top 

8) Portrait và Landscape là __________________ 

a) Page Orientation 

b) Paper Size 

c) Page Layout 

d) Page Margin 

9) Lựa chọn nào sau đây không thuộc nhóm font style?  

a) Bold 

b) Italics 

c) Regular 

d) Superscript 

10) Chức năng giúp người dùng có thể gửi cùng một mẫu thư đến cho nhiều người khác 

nhau gọi là gì 

a) Macros 

b) Template 

c) mail merge 

d) Merge cells 

11) Khi soạn thảo văn bản trong Word, Phím Home dùng để  

a) Di chuyển con trỏ về đầu của tài liệu 

b) Di chuyển con trỏ đầu của đoạn văn 

c) Di chuyển con trỏ đầu của màn hình 

d) Di chuyển con trỏ đầu dòng 

12) Tổ hợp phím Ctrl + phím mũi tên phải được dùng để  



a) Di chuyển con trỏ về bên phải của một từ  

b) Di chuyển con trỏ đến cuối dòng 

c) Di chuyển con trỏ cuối của tài liệu 

d) Di chuyển con trỏ xuống cuối của một đoạn 

13) Khi soạn thảo văn bản trong Word , phím End dùng để 

a) Di chuyển con trỏ đến cuối dòng 

b) Di chuyển con trỏ cuối của tài liệu 

c) Di chuyển con trỏ cuối của đoạn văn 

d) Di chuyển con trỏ cuối của màn hình 

14) Tổ hợp phím “Ctrl + PageDown” được sử dụng để di chuyển con trỏ đến 

a) Cuối một đoạn (Paragraph) 

b) Cuối trang (Page) 

c) Cuối dòng (Line) 

d) Cuối màn hình (Screen) 

15) Tổ hợp phím nào sau đây dùng để ẩn/hiện thanh Ribbon 

a) Ctrl + F11 

b) Ctrl + F1 

c) Shift + F1 

d) Alt + F1 

16) Thao tác nào sau đây thực hiện chức năng ngắt trang 

a) Đặt trỏ tại vị trí ngắt trang, chọn tab Insert-> Page Break 

b) Đặt trỏ tại vị trí ngắt trang, chọn tab Page Layout-> Breaks-> Page  

c) Đặt trỏ tại vị trí ngắt trang, chọn tab Insert-> Breaks-> Page 

d) Đặt trỏ tại vị trí ngắt trang, chọn tab Page Layout -> Page Break 

17) Lựa chọn nào sau đây dùng để ngắt phần (Section break) sao cho phần tiếp theo bắt 

đầu ở đầu trang tiếp theo 

a) Section Breaks-> Next Page 

b) Section Breaks-> Continuous 

c) Section Breaks-> Even Page 



d) Section Breaks-> Odd Page 

18) Lựa chọn nào sau đây dùng để ngắt phần (Section break) sao cho phần tiếp theo bắt 

đầu ở đầu trang chẵn tiếp theo 

a) Section Breaks-> Next Page 

b) Section Breaks-> Continuous 

c) Section Breaks-> Even Page 

d) Section Breaks-> Odd Page 

19) Lựa chọn nào sau đây không phải là tùy chọn của Section Break 

a) Next Page 

b) Previous Page 

c) Odd Page 

d) Even Page 

20) Mặc định, header và Footer xuất hiện ở trang nào? 

a) Trang đầu tiên của tài liệu 

b) Trang cuối cùng của tài liệu 

c) Những trang được chỉ định 

d) Tất cả các trang 

21) Chức năng nào dùng để thiết lập header và footer ở trang chẳn và trang lẻ có nội dung 

khác nhau? 

a) Different first page 

b) Different Odd & even pages 

c) Different sections 

d) Different Odd pages & Different even pages 

22) Thao tác nào để bật hoặc tắt thước (Ruler) trong cửa sổ soạn thảo  

a) Chọn tab Review-> đánh dấu chọn vào ô Ruler 

b) Chọn tab View-> đánh dấu chọn vào ô Ruler 

c) Chọn tab Insert  Ruler  

d) Chọn tab Page Layout-> đánh dấu chọn vào ô Ruler 

23) Chức năng Link to Previous được sử dụng để chỉ định _______________  



a) Section hiện tại tiếp tục sử dụng Header và Footer của section trước  

b) Section hiện tại tiếp tục sử dụng định dạng của section trước 

c) Section hiện tại tiếp tục với section trước trên cùng một trang 

d) Section hiện tại liên kết với section trước 

24) Lựa chọn nào không liên quan đến định dạng thụt lề của đoạn văn bản 

a) First line 

b) Hanging 

c) Left indent, Right indent 

d) Spacing 

25) Tính năng nào giúp chèn nội dung từ Clipboard như một văn bản không có  định dạng 

a) Paste Special 

b) Format Painter 

c) Page Setup 

d) Styles 

26) Tổ hợp phím nào dùng để mở hộp thoại Find and Replace, và tab Goto được kích hoạt  

a) Ctrl + G 

b) Ctrl + F 

c) Ctrl + H 

d) Ctrl + R 

27) Tổ hợp phím nào dùng để ngắt dòng 

a) Ctrl + Enter 

b) Ctrl + Shift + Enter 

c) Shift + Enter 

d) Alt + Enter 

28) Tổ hợp phím nào dùng để ngắt cột 

a) Ctrl + Enter 

b) Ctrl + Shift + Enter 

c) Shift + Enter 

d) Alt + Enter 



29) Thao tác nào sau đây dùng để thay đổi Font chữ của toàn bộ tài liệu 

a) Chọn tab Design-> Font-> chọn bộ Font cần thay đổi 

b) Chọn tab Home, chọn Font trong nhóm lệnh Font 

c) Chọn tab Home -> mở hộp thoại Font, chọn font cần thay đổi 

d) Chọn tab Design-> mở hộp thoại Font, chọn font cần thay đổi 

30) Tổ hợp phím Ctrl + Shift + C được sử dụng để ______________ 

a) Sao chép nội dung  

b) Sao chép định dạng 

c) Sao chép công thức 

d) Sao chép hình ảnh 

31) Tab stop position không thể canh lề kiểu  

a) Decimal 

b) Center 

c) Bar 

d) Justify 

32) Cách nào sau đây có thể sử dụng chức năng Format Painter nhiều lần 

a) Click biểu tượng Lock Format Painter  

b) Double click trên biểu tượng Format Painter 

c) Chọn View-> Format Painter -> Multiple Use 

d) Chức năng Format Painter không thể sử dụng nhiều lần 

33) Tổ hợp phím Ctrl + T được sử dụng để thực hiện chức năng ________  

a) Hanging Indent 

b) Left Indent 

c) Mở hộp thoại Tabs 

d) Đóng tất cả các hộp thoại đang mở 

34) Phần lề để đóng gáy sách (Gutter) có thể đặt ở vị trí nào? 

a) Lề trái và phải 

b) Lề trái và trên 

c) Lề trái và dưới 



d) Chỉ đặt ở lể trái 

35) Để đóng khung cho khối văn bản được chọn, thao tác nào sau đây là đúng 

a) Chọn khối văn bản, trong nhóm lệnh Paragraph, click nút borders, chọn Borders 

and Shading, chọn kiểu khung, OK 

b) Chọn khối văn bản, mở hộp thoại Paragraph, chọn kiểu khung 

c) Chọn khối văn bản, trong nhóm lệnh Paragraph, click nút borders, chọn Borders 

and Shading, chọn kiểu khung, trong mục Apply to, chọn Text, click OK 

d) Chọn khối văn bản, trong nhóm lệnh Paragraph, click nút borders, chọn kiểu 

khung trong danh sách 

36) Lựa chọn nào sau đây thực hiện xóa tất cả các định dạng của khối văn bản đang được 

chọn 

a) Nhấn phím Delete 

b) Click nút Clear All formatting trong nhóm lệnh Font 

c) Nhấn tổ hợp phím Shift Delete 

d) Không thể xóa định dạng 

37) Khi nhiều khối văn bản khác nhau được áp dụng cùng một Style, cách nào sau đây là 

tốt nhất dùng để hiệu chỉnh định dạng đồng thời cho các khối văn bản trên. 

a) Hiệu chỉnh Style đã được áp dụng 

b) Lần lượt chọn các khối văn bản và hiệu chỉnh định dạng 

c) Hiệu chỉnh định dạng của một khối sau đó dùng chức năng Format Painter 

d) Dùng chức năng Paste Special 

38) Lựa chọn nào sau đây dùng để chuyển dữ liệu trong một bảng thành dạng Text 

a) Đặt trỏ trong bảng, chọn tab Layout, click nút Convert to Text 

b) Chọn bảng, Click nút Border trong nhóm lệnh Paragraph, chọn No border  

c) Dùng chức năng eraser để xóa các cạnh của bảng 

d) Chọn bảng và nhấn phím Delete 

39) Khi đặt trỏ trong bảng dữ liệu thì trên thanh Ribbon xuất hiện một tab_________ chứa 

các lệnh để định dạng và hiệu chỉnh bảng 

a) Table Tools 



b) Table Format 

c) Table design 

d) Table Format and Design 

40) Chức năng nào sau đây dùng để xoay chữ trong một ô của bảng 

a) Text direction 

b) Text orientation 

c) Text rotate 

d) Không có chức năng xoay chữ trong ô 

41) Để kết hợp nhiều ô thành một ô trong bảng, thao tác nào sau đây là sai? 

a) Chọn các ô cần kết hợp, chọn tab Layout trong Table Tools, click nút Merge cells  

b) Chọn các ô cần kết hợp, click chuột phải, chọn Merge cells 

c) Chọn các ô cần kết hợp, chọn tab Design trong Table Tools,  click nút Merge cells 

d) Đặt trỏ trong bảng, click nút eraser trong nhóm lệnh Draw của tab Layout, xóa các 

cạnh của ô cần kết hợp 

42) Chức năng nào dùng để canh đều độ rộng của các cột trong bảng 

a) Distribute columns 

b) Distribute rows 

c) Distribute table 

d) Distribute cells 

43) Thao tác nào thực hiện tách một bảng thành 2 bảng riêng biệt 

a) Đặt trỏ tại dòng cần tách, chọn chức năng Split Table trong nhóm lệnh Merge của 

tab Layout 

b) Đặt trỏ tại dòng cần tách, click chuột phải, chọn Split Table 

c) Chọn dòng tại vị trí cần tách, chọn chức năng Delete Row 

d) Không thực hiện được chức năng tách bảng 

44) Khi một bảng kéo dài trên nhiều trang, cách nào sau đây làm cho tiêu đề của bảng lặp 

lại tại đầu của mỗi trang 

a) Đặt trỏ trong bảng, click nút repeat Header rows trong nhóm lệnh Data của tab 

Layout 

 tab Layout



b) Sao chép tiêu đề của bảng cho mỗi trang 

c) Click chuột phải trên dòng tiêu đề, chọn repeat Header rows 

d) Mặc định tiêu đề bảng lặp lại ở đầu của mỗi trang 

45) Thao tác nào sau đây không dùng để xóa một bảng 

a) Chọn bảng, click nút Delete trong mini Toolbar, chọn Delete Table 

b) Chọn bảng và nhấn phím Delete 

c) Chọn bảng, chọn tab Layout, click nút Delete, chọn Delete Table 

d) Chọn bảng, click chuột phải, chọn Delete table 

46) Phát biểu nào sau đây nói về Mini toolbar trong word 2013  

a) Thanh công cụ xuất hiện tại vị trí chọn khối văn bản 

b) Thanh công cụ nằm bên trên của thanh Ribbon 

c) Thanh công cụ không có sẵn trên thanh Ribbon 

d) Thanh công cụ chỉ có trong Word 2010 

47) Trong cùng một tài liệu, làm cách nào để có thể xoay trang theo hai hướng Portrait và 

Landscape 

a) Ngắt section 

b) Ngắt trang 

c) Ngắt đoạn 

d) Không thực hiện được 

48) Một hình chèn vào trang văn bản,và khi đươc chọn thì trên thanh Ribbon xuất hiện 

một tab chứa các công cụ định dạng cho hình, đó là tab gì 

a) Drawing tools 

b) Picture tools 

c) Shape tools 

d) Format tools 

49) Thao tác nào sau đây dùng để chèn Watemark vào trang 

a) Chọn tab Design-> Watemark 

b) Chọn tab Page layout-> Watemark 

c) Chọn tab Home ->Watemark 



d) Chọn tab Insert ->Watemark 

50) Số dòng tối đa có thể thiết lập ứng với chiều cao của một Drop cap 

a) 3 

b) 4 

c) 2 

d) 10 

 




